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Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website. 

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights 
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights 
of Renesas Electronics or others. 

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. 
4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by 
you or third parties arising from the use of these circuits, software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable export control 
laws and regulations and follow the procedures required by such laws and regulations.  You should not use Renesas 
Electronics products or the technology described in this document for any purpose relating to military applications or use by 
the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way 
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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IECUBE is a trademark of NEC Electronics Corporation. 

Windows is either a registered trademark or a trademark of Microsoft Corporation in the United States 

and/or other countries. 

PC/AT is a trademark of International Business Machines Corporation. 

Pentium is a trademark of Intel Corporation. 

 

The information in this document is current as of September, 2005. The information is subject to 
change without notice.  For actual design-in, refer to the latest publications of NEC Electronics data 
sheets or data books, etc., for the most up-to-date specifications of NEC Electronics products.  Not 
all products and/or types are available in every country.  Please check with an NEC Electronics sales 
representative for availability and additional information.
No part of this document may be copied or reproduced in any form or by any means without the prior       
written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that may 
appear in this document.
NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual 
property rights of third parties by or arising from the use of NEC Electronics products listed in this document 
or any other liability arising from the use of such products.  No license, express, implied or otherwise, is 
granted under any patents, copyrights or other intellectual property rights of NEC Electronics or others.
Descriptions of circuits, software and other related information in this document are provided for illustrative 
purposes in semiconductor product operation and application examples. The incorporation of these 
circuits, software and information in the design of a customer's equipment shall be done under the full 
responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.
While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics products, 
customers agree and acknowledge that the possibility of defects thereof cannot be eliminated entirely.  To 
minimize risks of damage to property or injury (including death) to persons arising from defects in NEC 
Electronics products, customers must incorporate sufficient safety measures in their design, such as 
redundancy, fire-containment and anti-failure features.
NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and 
"Specific".  
The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated "quality assurance program" for a specific application.  The recommended applications of an NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality grade of 
each NEC Electronics product before using it in a particular application. 

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc.  If customers wish to use NEC Electronics products in applications 
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to 
determine NEC Electronics' willingness to support a given application.

(Note)

•

•

•

•

•

•

M8E  02. 11-1

(1)

(2)

"NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its 
majority-owned subsidiaries.
"NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as 
defined above).

Computers, office equipment, communications equipment, test and measurement equipment, audio
and visual equipment, home electronic appliances, machine tools, personal electronic equipment
and industrial robots.
Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti-disaster
systems, anti-crime systems, safety equipment and medical equipment (not specifically designed
for life support).
Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, life
support systems and medical equipment for life support, etc.

"Standard":

"Special":

"Specific":
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GENERAL  PRECAUTIONS  FOR  HANDLING  THIS  PRODUCT 
 

1. Circumstances not covered by product guarantee 

• If the product was disassembled, altered, or repaired by the customer 

• If it was dropped, broken, or given another strong shock 

• Use at over voltage, use outside guaranteed temperature range, storing outside guaranteed 

temperature range 

• If power was turned on while the USB cable or target system connection was in an unsatisfactory 

state 

• If the USB cable, target cable, or the like was bent or pulled excessively 

• If the product got wet 

• If the product and target system were connected while a potential difference existed between the 

GND of the product and the GND of the target system 

• If an excessive load was placed on a connector or socket 

 

2. Safety precautions 

• Be careful of electrical shock.  There is a danger of electrical shock if the product is used as 

described above in 1. Circumstances not covered by product guarantee. 
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Regional Information

•  Device availability

•  Ordering information

•  Product release schedule

•  Availability of related technical literature

•  Development environment specifications (for example, specifications for third-party tools and
   components, host computers, power plugs, AC supply voltages, and so forth)

•  Network requirements

In addition, trademarks, registered trademarks, export restrictions, and other legal issues may also vary
from country to country.

[GLOBAL SUPPORT]
         http://www.necel.com/en/support/support.html

NEC Electronics America, Inc. (U.S.)
Santa Clara, California
Tel: 408-588-6000
       800-366-9782

NEC Electronics Hong Kong Ltd.
Hong Kong
Tel: 2886-9318

NEC Electronics Hong Kong Ltd.
Seoul Branch
Seoul, Korea
Tel: 02-558-3737

NEC Electronics Shanghai Ltd.
Shanghai, P.R. China
Tel: 021-5888-5400

NEC Electronics Taiwan Ltd.
Taipei, Taiwan
Tel: 02-2719-2377

NEC Electronics Singapore Pte. Ltd.
Novena Square, Singapore
Tel: 6253-8311

J05.6

NEC Electronics (Europe) GmbH
Duesseldorf, Germany
Tel:  0211-65030

• Sucursal en España
Madrid, Spain
Tel:  091-504 27 87

Vélizy-Villacoublay, France
Tel:   01-30-67 58 00

• Succursale Française

• Filiale Italiana
Milano, Italy
Tel:  02-66 75 41

• Branch The Netherlands
Eindhoven, The Netherlands
Tel:   040-265 40 10

• Tyskland Filial
Taeby, Sweden
Tel:  08-63 87 200

• United Kingdom Branch
Milton Keynes, UK
Tel:  01908-691-133

Some information contained in this document may vary from country to country.  Before using any NEC 
Electronics product in your application, pIease contact the NEC Electronics office in your country to 
obtain a list of authorized representatives and distributors.  They will verify: 
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PREFACE 
 

 

Target Readers This manual is intended for users who use the PG-FPL when designing and 

developing a system using an NEC Electronics on-chip flash memory 

microcontroller.  

 

Purpose This manual is intended to give users an understanding of the basic specifications 

and correct use of the PG-FPL. 

 By using the PG-FPL, programs can be easily erased from or written to the flash 

memory of an NEC Electronics On-chip flash memory microcontroller, or can be 

verified on WindowsTM screens, while the microcontroller is mounted on the user 

board.  

 

Organization This manual includes the following sections. 

 

• Overview 

• Hardware installation 

• Software installation 

• Operation using GUI software  

• Usage examples 

• Connectors and cables 

• Notes on target system 

• Circuit diagrams 

• Troubleshooting 

 

How to Read This Manual To understand the overall functions and usage of the PG-FPL, read this manual in 

the order of the CONTENTS.  

 Be sure to read CHAPTER 4  OPERATION USING GUI SOFTWARE because this 

chapter presents important information for using the PG-FPL.  

 It is assumed that the readers of this manual have general knowledge of electricity, 

logic circuits, and microcontrollers.  

 In the explanations of the operation of the applications, it is also assumed that the 

readers have sufficient knowledge of Windows.  

 For the usage and terminology of Windows 98, Windows Me, Windows 2000, and 

Windows XP, refer to each Windows manual. 
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Conventions Note:   Footnote for item marked with Note in the text 

Caution:   Information requiring particular attention 

Remark:   Supplementary information  

Numeral representation: Binary … ×××× or ××××B 

  Decimal … ×××× 

  Hexadecimal … 0××××H or ××××H 

“ ”:   Any character or item on screen 

 OK :   Name of button 

[ ]:   Menu 

< >:   Dialog box name 

 

Terminology The meanings of the terms used in this manual are as follows. 

Term Meaning 

FPL Abbreviation of flash memory programmer PG-FPL 

GUI software Windows application to operate PG-FPL using GUI software 

Target device NEC Electronics on-chip flash memory microcontroller 

Target system User-designed board on which NEC Electronics on-chip flash 

memory microcontroller is mounted 

FP4 connector Abbreviation of PG-FP4 target connector (type A) 

FA adapter Adapter board to write programs to NEC Electronics on-chip flash 

memory microcontrollerNote 

IECUBETM General name of NEC Electronics high-performance/compact in-

circuit emulator 

 

Note The FA adapter board is a product of Naito Densei Machida Mfg. Co., Ltd. 

 If you have any questions about the FA adapter board, contact: 

    Naito Densei Machida Mfg. Co., Ltd. Tel: +81-45-475-4191 
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CHAPTER  1   OVERVIEW 
 

 

The FPL is a tool that erases, writes, and verifies programs on an NEC Electronics on-chip flash memory 

microcontroller on the target board.   

 

1.1 Features 
 

• The PG-FPL is a compact flash memory programmer for an on-chip flash memory microcontroller, and is 

designed for development. 

• The USB interface is available for connection with the host. 

• The PG-FPL allows on-board programming without removing the target device from the target system. 

• Only UART interface is supported for data transfer to the target device. 

• Device-specific parameters required for writing are read from a parameter file (PRM file). 
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CHAPTER  2   HARDWARE  INSTALLATION 
 

 

2.1 System Requirements 
 

OS A PC supporting Windows 98, Windows Me, Windows 2000, or Windows XP is needed. 

 About 2 MB of free hard disk space is required to install the GUI software. 

Host machine IBM PC/ATTM or compatible 

 CPU: PentiumTM 100 MHz or more 

 RAM: 32 MB or more 

Host interface USB interface that enables communication based on USB (Ver. 1.1 or later). 

File formats Program files can be used in Motorola HEX file format or Intel HEX file format. 

 

2.2 Package Contents 
 

Please verify that you have received all the parts listed in the package contents list included with the FPL package.  

If any part is missing or seems to be damaged, please contact an NEC Electronics sales representative or distributor. 
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2.3 System Configuration and Components 
 

The FPL system configuration is as given in the diagram below. 

 

Figure 2-1.  FPL System Configuration 
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        Target cable   FPL-FA 

  PG-FPL 

 FA adapterNote 2 

IECUBE Accessory Disk 

Target system not based 

on FP4 connector 

 
Notes  1.  Use the USB cable (Mini-B type) included with the IECUBE. 

 2.  The FA adapter board is a product of Naito Densei Machida Mfg. Co., Ltd. 

 

The FPL is connected to the host machine via the USB cable (Mini-B type).  The FPL is connected to the user 

system via the target cable.  For the detailed specifications of the target cable and connector, refer to CHAPTER 6 

CONNECTORS AND CABLES. 

 

2.3.1 FPL display specifications, connector, and MODE switch settings 

 

Figure 2-2.  Layout Drawing of Connectors and LEDs 

 

 

             
 

 

 

MODE switch 

Target cable connector 

USB connector 

Power LED Status LED 



CHAPTER  2   HARDWARE  INSTALLATION 

User’s Manual  U17788EJ1V0UM 13

Target cable connector: Used to connect the connector of the target cable. 

USB connector:  Used to connect the USB cable to be connected to the host machine. 

Power LED:  Turned on in green when the FPL is connected to the host machine. 

Status LED:  Blinks in red when the FPL is communicating with the target device. 

 

Caution When the Status LED is blinking, communication with the target device is in progress.  Do not 

disconnect the target cable and USB cable. 

 

MODE switch: Switches power to be supplied to the target system. 

 

Table 2-1.  MODE Switch Setting Table 

MODE 1 2 3 4 

VDD Target 3.3 V 5 V 5 V 

VDD2 Target N.C. N.C. 3.3 V 

 

[MODE switch setting] 

MODE1: Used when VDD/VDD2 is supplied from the target system. 

MODE2: Used when the FPL supplies power to a target system with 3.3-V VDD. 

  (The VDD2 pin is placed in the high-impedance state.) 

MODE3: Used when the FPL supplies power to a target system with 5-V VDD. 

  (The VDD2 pin is placed in the high-impedance state.) 

MODE4 : Used when the FPL supplies power to a target system with 5-V VDD and 3.3-V VDD2. 
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2.3.2 FPL-FA connector 

 

Figure 2-3.  Layout Drawing of FPL-FA Connectors 

 

 

 

       
 

 

  

Target connector: Used to connect the tip of the target cable. 

FP4 connector: Used to connect the FA adapter board or target system. 

 

2.3.3 Target system 

The target system must be equipped with a device interface that complies with the target cable specifications.   

Refer to CHAPTER 6  CONNECTORS AND CABLES for details. 

 

2.3.4 USB connector 

The shape of the USB connector is a Mini-B type. 

Refer to CHAPTER 6  CONNECTORS AND CABLES for details. 

 

2.3.5 Target cable 

The tip of the target cable can be connected to the header pin that is 0.635 mm by 0.635 mm. 

Refer to CHAPTER 6  CONNECTORS AND CABLES for details. 

 

Target connector 

FP4 connector 

Component side (front) Soldering side (rear) 
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2.3.6 Connection procedure 

The procedure for connecting the FPL is described below. 

 

Caution Be sure to install the software (GUI software driver) before making connections. 

 

(1) Set the MODE switch according to the power supply of the target system. 

 

Caution Be sure to set the MODE switch before making connections with the host machine and target 

system.  If connections are made based on an incorrect setting, the FPL and target system 

may be damaged. 

 

Figure 2-4.  MODE Switch Setting 

 

  
 

(2) Connect the host machine with the FPL via the USB cable.  (Check that the Power LED is turned on in green.) 

 

Cautions 1. Be sure to perform this step before making a connection with the target system.  If 

connections are made in an incorrect order, the FPL and target system may be damaged. 

 2. If the MODE switch is set to MODE2, MODE3, or MODE4 (power is supplied from the FPL), 

the voltage set on the VDD/VDD2 pin is output when the FPL is connected with the host 

machine. 

 

(3) Connect the target system with the FPL (follow either setting (a) or (b)).  

 

(a) When FPL is connected with a target system that has a 16-pin connector usable with the FP4 connector 

 

<1> Connect the tip of the target cable with the target connector of the FPL-FA. 

 Connect the tip of the target cable with the target connector of the FPL-FA so that the number marked 

on the tip of the target cable matches to the number marked on the FPL-FA board. 

 

Remark The FPL-FA is connected with the target cable at shipment. 

 

 

Set the MODE switch. 

1: Target/Target 

2: 3.3 V/N.C. 

3: 5 V/N.C. 

4: 5 V/3.3 V 
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Figure 2-5.  Connecting Target Cable with FPL-FA 

 

  
 

 

 

 

 

<2> Make sure that the power to the target system is not turned on. 

 

Caution Make sure that the power to the target system is not turned on before connecting 

the target cable.  If the target cable is connected after the power to the target system 

is turned on, the FPL may be damaged. 

 

<3> Connect the FP4 connector with the connector installed in the target system. 

 

Caution When MODE2, MODE3, or MODE4 is set, VDD/VDD2 is output from the FP4 

connector.  Before inserting or removing a device on the target system, be sure to 

detach the FP4 connector. 

 

<4> Be sure to turn on the power to the target system. 

 (When MODE2, MODE3, or MODE4 is set, power is supplied from the FPL, so that this step is not 

required.) 

 

(b) When the FPL is connected with the target system without using the FPL-FA 

 

<1> Disconnect the FPL-FA from the target cable. 

<2> Make sure that the power to the target system is not turned on. 

 

Caution Make sure that the power to the target system is not turned on before connecting 

the target cable.  If the target cable is connected after the power to the target system 

is turned on, the FPL may be damaged. 

 

<3> Connect the tip of the target cable marked “0.GND” to GND of the target system. 

 

Caution Be sure to connect “0.GND” at the beginning.  If connections are made in an 

incorrect order, the FPL and target system may be damaged. 

 

<4> Make sure that the power to the target system is not turned on. 

Match the number. 

Tip of target cable 

 0. G
N

D
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<5> Connect the tip of the target cable marked “1.VDD” to VDD of the target system. 

 

Caution Be sure to make connections in the order from “0.GND” to “1.VDD” to “other 

signals”.  If connections are made in an incorrect order, the FPL and target system 

may be damaged. 

<6> Connect the tip of the target cable marked "2.VDD2" to VDD2 of the target system. 

 

Caution Be sure to make connections in the order from "0.GND" to "1.VDD" to "2.VDD2" to 

"other signals".  If connections are made in an incorrect order, this product and 

target system can be damaged. 

 

<7> Connect the tips of other target cables to the target system. 

<8> Turn on the power to the target system. 

 (When MODE2, MODE3, or MODE4 is set, power is supplied from the FPL, so that this step is not 

required.) 

 

2.3.7 Disconnection procedure 

 

(1) When communication with the target system ends, terminate the GUI software. 

 

(2) Disconnect the FPL from the target system.  Follow either procedure (a) or (b) according to the connection 

method. 

 

(a) When the FPL is connected with the target system by using the FPL-FA 

 

<1> Turn off the power to the target system. 

 (When MODE2, MODE3, or MODE4 is set, power is supplied from the FPL, so that this step is not 

required.) 

<2> Disconnect the FPL-FA from the target system. 

 

Caution When MODE2, MODE3, or MODE4 is set, the FPL outputs power at all times.  Before 

disconnecting the target device, be sure to disconnect the FP4 connector from the 

target system. 

 

(b) When the FPL is connected with the target system without using the FPL-FA 

 

<1> Turn off the power to the target system. 

 (When MODE2, MODE3, or MODE4 is set, power is supplied from the FPL, so that this step is not 

required.) 

<2> Disconnect the tips of the target cables marked “3./RESET”, “4.TXD”, “5.RXD”, and “6.FLMD0” from 

the target system. 

 

Caution Be sure to disconnect the target cables in the following order (<3> and <4> and <5>).  

If the target cables are disconnected in an incorrect order, the target system or the 

FPL may be damaged. 

 

<3> Disconnect the tip of the target cable marked "2.VDD2" from the target system. 

<4> Disconnect the tip of the target cable marked “1.VDD” from the target system. 



CHAPTER  2   HARDWARE  INSTALLATION 

User’s Manual  U17788EJ1V0UM 18 

<5> Disconnect the tip of the target cable marked “0.GND” from the target system. 

 

(3) Disconnect the USB cable from the host machine.  (Make sure that the Power LED is turned off.) 

 

(4) Disconnect the USB cable from the FPL. 
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CHAPTER  3   SOFTWARE  INSTALLATION 
 

 

3.1 GUI Software Installation 
 

The GUI software allows easy and comfortable access to all features of the FPL flash programmer.  

The installation program is contained in the CD-ROM (IECUBE Accessory Disk) included with the IECUBE 

package. 

Execute the following steps to install the GUI software. 
 

(1) When using Windows XP, log on as the computer administrator.  When using Windows 2000, log on as the 

Administrator. 
 

(2) Insert the CD-ROM (IECUBE Accessory Disk) included with the IECUBE package into the CD-ROM drive. 
 

(3) Double-click “My Computer”, “CD-ROM”, “PG-FPL”, and “SETUP” in that order.  Double-click “setup.exe” in the 

SETUP folder. 
 

(4) Select a language to be used for installation (“English” in this example), then click   OK  . 
 

Figure 3-1.  Setup Language Selection 
 

 
 

(5) After selecting the language, the window shown below is displayed. 

 Click  Next >  to continue installation. 
 

Figure 3-2.  Installation Start 
 

 

Select language 
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(6) The software License Agreement window appears.  Read the displayed license agreement carefully, then click  

   Yes  if you accept the agreement.  You need to accept the agreement before using the PG-FPL.  If you do not 

accept the agreement, click  No  to terminate the installation of the software. 
 

Figure 3-3.  License Agreement Window 
 

 
 

(7) Check that “Typical” is selected, then click  Next > . 
 

Figure 3-4.  Setup Type 
 

 
 

Remark By selecting Custom, only the GUI software or document can be installed.  The GUI software 

installation destination can be changed by clicking  Browse... .  This manual assumes the default 

installation folder. 

Check that “Typical” is selected.
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•  When  Browse...  is clicked 

 The directory selection window is displayed.  Specify the path for the installation folder and then click  OK . 

 

Figure 3-5.  Changing Installation Folder 

 

 
 

•  When Custom is clicked 

 Select the check box of the item to be installed and then click  Next > . 

 

Figure 3-6.  Custom Installation 

 

 

 

Check here when installing documents.

Click after confirming the check boxes. 

Check here when installing the GUI software. 

Specify an installation destination folder path. 
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(8) Specify or select the program folder and then click  Next > . 

 

Figure 3-7.  Program Folder Selection 

 

 
 

(9) Confirm the current setting and then click  Next > .  (Program installation starts.) 

 

Figure 3-8.  Start of File Copy Operation 
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(10) When installation of the GUI software is complete, the screen shown below appears.  Click  Finish  to 

terminate the installer. 

 

Figure 3-9.  Completion of Installation 

 

 
 

(11) The following folders are created upon completion of installation. 

 

Figure 3-10.  Folder Configuration After Installation 

 
C:\

\Program Files

\NECTools32

\bin

\PRM

\doc

\PG-FPL
[ FPL.exe ]
[ Prrctl.dll ]

\DRIVER

[ Ftdiunin.exe ]
Other driver-related files

\PG-FPL
[ PG-FPL_UM_E.pdf ]

\FTDI

Folder specified as the installation destination

PRM file storage folder

GUI software

This manual

Driver uninstallation execution file
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3.2 Driver Installation  
 

The driver needs to be installed in the host machine before using the FPL.  Install the driver according to the 

following procedure. 

 

Installation in Windows 98/Me:  See 3.2.1  Installation in Windows 98/Me 

Installation in Windows 2000: See 3.2.2  Installation in Windows 2000 

Installation in Windows XP:  See 3.2.3  Installation in Windows XP 

 

3.2.1 Installation in Windows 98/Me 

 

(1) When the FPL is connected with the host machine, the FPL is recognized by Plug and Play, and the wizard for 

adding new hardware is started.   

 

(2) The window below is displayed.  Check that “Specify the location ...” is selected, then click  Next > . 

 

Figure 3-11.  Search Method (Windows Me) 

 

 
 

Check that “Specify the location ...” 

is selected. 
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(3) Check the “Specify a location” check box only and enter “C:\Program Files\NECTools32\bin\PG-

FPL\DRIVER\FTDI” in the address bar, then click  Next > . 

 

Figure 3-12.  Search Location Specification (Windows Me) 

 

 
 

 

Remark If the installation destination folder is changed for GUI software installation, enter “new-

folder\bin\PG-FPL\DRIVER\FTDI”. 

 

(4) The window below is displayed.  Confirm the contents and click  Next > . 

 

Figure 3-13.  Checking Driver to Be Installed (Windows Me) 

 

 
 

<1> Check “Specify a location” 

only. 

<2>  Enter “C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI”. 
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(5) When installation of the USB driver is complete, the screen shown below appears.  Click  Finish .  

Subsequently the installation of the USB Serial Port driver is automatically performed. 

 

Figure 3-14.  Completion of Installation (Windows Me) 
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3.2.2 Installation in Windows 2000 

 

(1) When the FPL is connected with the host machine, the FPL is recognized by Plug and Play, and the wizard for 

finding new hardware is started.  Click  Next > . 

 

Figure 3-15.  Found New Hardware Wizard (Windows 2000) 

 

 
 

(2) The window below is displayed.  Check that “Search for a suitable driver ...” is selected, then click  Next > . 

 

Figure 3-16.  Search Method (Windows 2000) 

 

 
 

Check that “Search for a 

suitable driver ...” is selected. 
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(3) Check the “Specify a location” check box only, then click  Next > . 

 

Figure 3-17.  Driver File Location (Windows 2000) 

 

 
 

(4) Enter “C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI” in the address bar, then click  OK . 

 

Figure 3-18.  Address Specification (Windows 2000) 

 

 
 

 

 

 

Remark If the installation destination folder is changed for GUI software installation, enter “new-

folder\bin\PG-FPL\DRIVER\FTDI”. 

 

Check that “Specify a location” 

only is checked. 

Enter “C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI”. 
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(5) The driver file is searched and the window below is displayed.  Click  Next > . 
 

Figure 3-19.  Driver File Search (Windows 2000) 
 

 
 

(6) When installation of the USB driver is complete, the screen shown below appears.  Click  Finish  to complete 

installation.  When installation is complete, restart the computer following the instructions as restart is 

requested. 
 

Figure 3-20.  USB Driver Installation Completion (Windows 2000) 
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(7) Subsequently the installation of the USB Serial Port driver is started.  Click  Next > . 

 

Figure 3-21.  Found New Hardware Wizard 2 (Windows 2000) 

 

 
 

(8) The window below is displayed.  Check that “Search for a suitable driver ...” is selected, then click  Next > . 

 

Figure 3-22.  Search Method 2 (Windows 2000) 

 

 
 

Check that “Search for a 

suitable driver ...” is selected. 
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(9) Check the “Specify a location” check box only, then click  Next > . 

 

Figure 3-23.  Driver File Location 2 (Windows 2000) 

 

 
 

(10) Enter “C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI” in the address bar, then click  OK . 

 

Figure 3-24.  Address Specification 2 (Windows 2000) 

 

 
 

 

 

Remark If the installation destination folder is changed for GUI software installation, enter “new-

folder\bin\PG-FPL\DRIVER\FTDI”. 

 

Check that “Specify a 

location” only is checked. 

Enter “C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI”. 
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(11) The driver file is searched and the window below is displayed.  Click  Next > . 

 

Figure 3-25.  Driver File Search 2 (Windows 2000) 

 

 
 

(12) When installation of the USB driver is complete, the screen shown below appears.  Click  Finish  to complete 

installation. 

 

Figure 3-26.  USB Driver Installation Completion 2 (Windows 2000) 
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3.2.3 Installation in Windows XP 

 

(1) When the FPL is connected with the host machine, the FPL is recognized by Plug and Play, and the wizard for 

finding new hardware is started.  Check that “No, not this time” is selected, then click  Next > . 

 

Figure 3-27.  Found New Hardware Wizard (Windows XP) 

 

 
 

(2) Check that “Install from a list or specific …” is selected, then click  Next > . 

 

Figure 3-28.  Installation Method Selection (Windows XP) 

 

 
 

Check that “Install from a list 

or specific ...” is selected. 

Check that “No, not this time” 

is selected. 
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(3) Check that “Search for the best driver in these locations.” is selected.  Check the “Include this location in the 

search:” check box and enter “C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI” in the address bar, 

then click  Next > . 
 

Figure 3-29.  Search Method (Windows XP) 
 

 
 

Remark If the installation destination folder is changed for GUI software installation, enter “new-

folder\bin\PG-FPL\DRIVER\FTDI”. 
 

(4) When installation of the USB driver is complete, the screen shown below appears.  Click  Finish  to complete 

installation. 
 

Figure 3-30.  USB Driver Installation Completion (Windows XP) 
 

 

<2> Check “Include 

this location in 

the search:” only. 

<3>  Enter “C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI”. 

<1> Check that “Search for the best driver 

in these locations.” is selected. 
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(5) Subsequently the installation of the USB Serial Port driver is started.   

The wizard for finding new hardware is started.  Check that “No, not this time” is selected, then click  Next > . 

 

Figure 3-31.  Found New Hardware Wizard 2 (Windows XP) 

 

 
 

(6) Check that “Install from a list or specific …” is selected, then click  Next > . 

 

Figure 3-32.  Installation Method Selection (Windows XP) 

 

 
 

Check that “Install from a list 

or specific ...” is selected. 

Check that “No, not this time” 

is selected. 
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(7) Check that “Search for the best driver in these locations.” is selected.  Check the “Include this location in the 

search:” check box and enter “C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI” in the address bar, 

then click  Next > . 
 

Figure 3-33.  Search Method 2 (Windows XP) 
 

 
 

Remark If the installation destination folder is changed for GUI software installation, enter “new-

folder\bin\PG-FPL\DRIVER\FTDI”. 
 

(8) When installation of the USB driver is complete, the screen shown below appears.  Click  Finish  to complete 

installation. 
 

Figure 3-34.  USB Serial Port Driver Installation Completion (Windows XP) 
 

 

<2> Check “Include 

this location in 

the search:” only. 

<3>  Enter “C:\Program Files\NECTools32\bin\PG-FPL\DRIVER\FTDI”. 

<1> Check that “Search for the best driver 

in these locations.” is selected. 
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3.3 Confirmation of USB Driver Installation 
 

After installing the two types of drivers, check that the drivers have been installed normally, according to the 

procedure below.   When using the FPL, the information to be checked here is needed. 

 

Click the “Device Manager” tab and check that the drivers are installed normally. 

 

Figure 3-35.  Device Manager  

 

 
 

Cautions 1. When using the FPL in Windows 98/Me, do not select  Refresh  or  Remove  when 

communicating with the target device. 

 2. When using the FPL in Windows 2000/XP, do not perform “Scan for hardware changes” when 

communicating with the target device. 

 

Remarks 1. Select the same communication port as COM? for the USB Serial Port (COM?) in the GUI Port list 

box. 

 2. If the drivers above are not displayed, or the mark “×” or “!” is prefixed, refer to CHAPTER 9 

TROUBLESHOOTING. 

 

Check that “USB Serial Converter” is present. 

Check that “USB Serial Port (COM?)” is present. 
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3.4 Uninstallation 
 

3.4.1 Driver uninstallation 

The uninstallation program for the driver is installed in the host machine when the GUI software is installed.  Use 

the procedure below for driver uninstallation. 

 

(1) When using Windows XP, log on as the computer administrator.  When using Windows 2000, log on as the 

Administrator. 

 

(2) Double-click “My Computer”, “(C:)”, “Program Files”, “NECTools32”, “bin”, “PG-FPL”, “DRIVER”, and “FTDI” in 

that order.  Double-click “Ftdiunin.exe” in the FTDI folder. 

 

(3) Uninstaller starts, so click  Continue . 

 

Figure 3-36.  Driver Uninstaller 

 

 
 

(4) When uninstallation of the USB driver is complete, the screen shown below appears.  Click  Finish  to complete 

uninstallation of the driver. 

 

Figure 3-37.  Driver Uninstallation Completion 

 

 
 

Caution When the GUI software is uninstalled first, “Ftdiunin.exe” is deleted with it.  At this time, 

manually delete “USB Serial Port (COM?)” and “USB Serial Converter” from the Device 

Manager. 

 



CHAPTER  3   SOFTWARE  INSTALLATION 

User’s Manual  U17788EJ1V0UM 39

3.4.2 GUI software uninstallation 

The uninstallation program is contained in the CD-ROM (IECUBE Accessory Disk) included with the IECUBE 

package (this program is used commonly as the installer).  Use the procedure below for GUI software uninstallation. 

 

(1) When using Windows XP, log on as the computer administrator.  When using Windows 2000, log on as the 

Administrator.  

 

(2) Insert the CD-ROM (IECUBE Accessory Disk) included with the IECUBE package into the CD-ROM drive. 

 

(3) Double-click “My Computer”, “CD-ROM”, “PG-FPL”, and “SETUP” in that order.  Double-click “setup.exe” in the 

SETUP folder. 

 

(4) Select a language to be used for installation (“English” in this example), then click   OK  . 

 

Figure 3-38.  Setup Language Selection 

 

 
 

(5) Select “Remove”, then click   Next >  . 

 

Figure 3-39.  Program Modification 

 

 
 

Select language 

Select “Remove”. 
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(6) Click  OK  to start uninstallation. 

 

Figure 3-40.  Confirmation of File Deletion 

 

 
 

(7) When uninstallation of the GUI software is complete, the screen shown below appears.  Click  Finish  to 

complete uninstallation. 

 

Figure 3-41.  Completion of Maintenance 
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CHAPTER  4   OPERATION  USING  GUI  SOFTWARE 
 

 

4.1 Introduction 
 

Before you start using the FPL, download the parameter file for the target device (.PRM) to the PRM folder. 

 

<Downloading the parameter file> 

The PRM file is not part of the FPL software package.  

It has to be downloaded from the following NEC Electronics website. 

 

http://www.necel.com/micro/ods/eng/index.html (website in English) 

http://www.necel.com/micro/ods/jpn/index.html (website in Japanese) 

 

The PRM file downloaded from the NEC Electronics website must be copied into the sub-directory <FPL.EXE-

installation-path>\PRM which was created during GUI software setup (see CHAPTER 3 SOFTWARE 

INSTALLATION).  

 

4.2 Starting up GUI Software 
 

• GUI software startup 

Select FPL.EXE in the Start menu to start the FPL GUI software. 

When the GUI software is started normally, the following screen appears. 

 

Figure 4-1.  GUI Software Main Window  

 

 
 

Status bar 

Toolbar 

Menu bar 

Action log window 

Programmer parameter window 
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This window consists of the following items. 
 

Name Description of Display 

Menu bar (displayed at the top) Displays menu items executable by the FPL. 

Toolbar (displayed under the menu bar) Displays frequently used commands as icons. 

Action log window (displayed under the toolbar) Displays an FPL action log. 

Programmer parameter window 

(displayed to the right of the action log window) 

Displays programming parameter settings. 

Status bar Displays status. 

 

4.3 Toolbar 
 

The toolbar contains buttons to start the most important procedures of the FPL. 

 

Table 4-1.  Toolbar Buttons 

 

[Device] – [Setup…] button 

  

 

[File] – [Load…] button 

  

 

[Device] – [Blank check] button 

  

 

[Device] – [Erase] button 

  

 

[Device] – [Program] button 

  

 

[Device] – [Verify] button 

  

 

[Device] – [Autoprocedure (EPV)] button 

 

4.4 Menus 
 

Depending on the actual device status or device type, some menu items may be enabled or disabled.  

 

4.4.1 [File] menu 

After clicking the [File] menu, the following pull-down menu is displayed. 

Commands related to file operation appear here. 
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Figure 4-2.  [File] Menu 

 

 
 

(1) [Load] command  

The [Load] command allows you to select a program file.  The selected program file will be 

programmed into the device’s flash memory by executing the [Program] command or [Autoprocedure 

(EPV)] command. 

 

Figure 4-3.  HEX File Selection Window 

 

 
 

The most recently used directory from which a file has been loaded will be offered in this window as the default 

selection.  After loading the user program, the checksum is calculated and the result is displayed in the 

programmer parameter window.  The checksum is Arithmetic checksum (subtraction).  It calculates the program 

file from START to END.   

 

[ Open  button] 

Selects a user program as a program to be written to the target device. 

 

[ Cancel  button] 

Closes the window without selecting a program. 

 

(2)  [Quit] command 

The [Quit] command terminates the FPL GUI software.  Clicking the  X  button on the right side of the task bar 

also terminates the FPL GUI software. 

User settings are saved in the FPL.ININote file so that the GUI software will start up next time with the same 

settings. 
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Note FPL.INI is created in the Windows folder when Windows 98, Windows Me, or Windows XP is used. 

 When Windows 2000 is used, FPL.INI is created in the Winnt folder. 

4.4.2 [Device] menu 

Clicking the [Device] menu displays the following pull-down menu.  

This pull-down menu mainly consists of commands for programming the target device, such as erase, program, 

and verify. 

 

Figure 4-4.  [Device] Menu 

 

 
 

(1) [Blank Check] command 

The [Blank Check] command initiates a blank check of the target device connected to the FPL.  If the 

flash memory of the target device is erased, the blank check terminates successfully.  If the flash 

memory is not completely erased, “not blank” is displayed.  Erase the flash memory of the target device before 

starting programming. 

 

(2) [Erase] command 

The [Erase] command initiates the erase procedure for the target device connected to the FPL. 

While erasing the contents in the flash memory is in progress, the progress is displayed in the action 

log window, indicating the operation of the programmer. 

The [Blank Check] command that is executed before the [Erase] command is executed in accordance with the 

setting of ‘Command options’ on the Advance tab of the [Device] > [Setup…] menu. 

After completing the [Erase] command, the GUI software displays the target device command execution result. 

 

Caution During an erase operation, the Status LED is not turned on.  Do not disconnect the target 

cable and USB cable until the GUI software displays “Erase finished”.  Otherwise, the target 

device may be damaged. 
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(3) [Program] command 

The [Program] command transmits the specified user program to the target device and writes them to 

the flash memory.   

After execution of the [Program] command, verification to detect a communication error of the user program 

from the FPL to the target device is executed in accordance with the setting of ‘Command options’ on the 

Advance tab of the [Device] > [Setup…] menu. 

While programming is in progress, the progress is displayed in the action log window, indicating the operation 

of the programmer.  This progress indicates the progress of programming the target device as a percentage. 

After completing the [Program] command, the GUI software displays the target device command execution 

result. 

 

(4) [Verify] command 

The [Verify] command transmits the specified user program to the target device connected to the 

FPL and verifies the data written to the flash memory of the target device. 

While verification is in progress, the progress is displayed in the action log window, indicating the 

operation of the programmer.  This progress indicates the progress of verifying the target device as a 

percentage. 

After completing the [Verify] command, the GUI software displays the target device command execution result. 

 

(5) [Security] command 

This command is not supported. 

 

(6) [CheckSum] command 

The [CheckSum] command initiates the reading of the checksum values of the target device connected to the 

FPL.  The checksum is Arithmetic checksum (subtraction).  The checksum value in the flash memory area 

selected in Operation Mode on the Standard tab of the [Device] > [Setup…] menu is read.  This value differs 

from the value displayed in the parameter window in the main window. 

 

(7) [Autoprocedure (EPV)] menu 

The [Autoprocedure (EPV)] command sequentially executes the [Erase] and [Program] commands 

explained above. 

After execution of the [Autoprocedure (EPV)] command, to verify the checksum values of the data written to the 

flash memory of the target device and the program file to detect a communication error of the user program 

while it is being transmitted, specify automatic execution of the [Verify] command after execution of the 

[Program] command, using the Command options on the Advance tab of the [Device] > [Setup…] menu.  

During EPV, the progress status of the programmer operation is displayed in the action log window.  Refer to 

CHAPTER 5  USAGE EXAMPLE for the selected command, and its execution operation and message. 

After completing the [Autoprocedure (EPV)] command, the GUI software displays the target device command 

execution result. 

 

(8) [Signature read] command 

The [Signature read] command reads the target signature information (such as device name and flash memory 

information). 
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(9)  [Setup…] command 

The [Setup] menu allows you to make settings related to flash memory rewriting according to the 

user environment and to set command options.  Each time the GUI software is started, the most 

recently used parameter file (.PRM) is read and the settings are displayed.  The [Setup] menu allows you to 

modify the settings of items other than those items consisting of shadowed characters according to the user 

environment. 
 

(a) Standard setup 

This menu is used to set the rewriting environment of the target device’s flash memory.  

The mode of communication with the target device and the operating clock of the device differ depending 

on the device used.  Refer to the manual of the device used for details. 

The following window opens. 

 

Figure 4-5.  Device Setup Window – Standard Tab 

 

 
 

This window shows all basic options that can be set in accordance with the user environment and target 

device.   

 

[ OK  button] 

Saves the settings in the Standard and Advance tabs and closes the window. 

 

[ Cancel  button] 

Closes the window without saving the settings in the Standard and Advance tabs. 

 



CHAPTER  4   OPERATION  USING  GUI  SOFTWARE 

User’s Manual  U17788EJ1V0UM 47

<1> Parameter file 

This file holds parameters and timing data required to rewrite the flash memory of the target device.  

Do not modify the data in the parameter file because the data is related to the guarantee of rewrite 

data. 

The parameter file is protected by the checksum function.  If the checksum result indicates an error, 

the FPL does not accept the parameter file. 

 

Figure 4-6.  Device Setup Window – Parameter File Selection 

 

 
 

Figure 4-7.  Parameter File Selection Window 

 

 
 

[ PRM File Read  button] 

A window for specifying a parameter file is displayed.  Specify the target file and click  Open . 

 

<2> Communication interface to device 

"Communication interface to device" is used to select a channel for communication between the FPL 

and host machine.  

 

Figure 4-8.  Setup Window - Communication interface to device 

 

 
 

[Port box] 

Select a channel for communication between the FPL and host machine. 

• COM1 to COM256 
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Remark Selectable ports can be checked using Device Manager.  For details, refer to 3.3 

Confirmation of USB Driver Installation. 

 

[Speed box] 

Select a communication rate for the selected communication channel from the following: 

• 9600 bps 

• 19200 bps 

• 38400 bps 
 

Remark For selectable communication rates, refer to the user's manual of the device used. 
 

<3> Supply oscillator 

Select the clock that determines the programming, data transfer, and transfer rates, in this area. 

 

Figure 4-9.  Device Setup Window – Supply Oscillator 
 

 
 

[Frequency box] 

Sets the clock frequency of the target system.  

The range of operating frequency varies from one device to another.  So, check the specifications of 

the device used before making a setting. 

 

[Multiply rate] 

Sets the division rate or multiplication rate of the target device. 

If the target device includes the PLL circuit, input the division rate or multiplication rate depending on 

the environment used. 

Since the division rate or multiplication rate varies depending on the device, set it by checking the 

device specifications. 

If the target device does not include the PLL circuit, select “1.0”. 

The default setting is displayed by the parameter file in the initial screen. 
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<4> Operation Mode  

The flash memory may be divided into blocks or areas depending on the target device.  

This menu is used to select the operation mode of the flash memory.  Some devices do not have 

either or both division modes Block and Area.  In this case, a mode that is not available cannot be 

selected. 

 

Figure 4-10.  Device Setup Window – Operation Mode Selection 

 

 
 

[When Chip is selected] 

The entire flash memory area of the target device is subject to rewrite processing. 

 

[When Block is selected] 

Specify the Block number range subject to rewrite processing by using Start/End.  

The Start/End list boxes display the Block number where the flash memory of the target device is 

configured.  
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[When Area is selected] 

Specify the Area number range subject to rewrite processing by using Start/End. 

The Start/End list boxes display the Area number where the flash memory of the target device is 

configured. 

 

[Show Address check box] 

Specifies whether numbers or addresses are displayed in the Start/End list boxes.  

If this check box is checked, addresses are displayed. 

If it is not checked, numbers are displayed. 

 

<5> Target Reset Message 

By checking the Target Reset Message check box, the window promoting the reset operation 

manually is displayed even when the reset signal cannot be connected to the target cable. 

 

Figure 4-11.  Device Setup Window − Target Reset Message 

 

 
 

Remark The Target Reset Message check box is common to Standard and Advance tabs. 
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(b) Advance setup 

This menu is used to specify command options and security flag setting. 

The Advance tab is displayed by clicking Advance. 

 

Figure 4-12.  Device Setup Window – Advance Tab 

 

 
 

<1> Command options 

Specify the options for the FPL flash processing commands in this area. 

 

Figure 4-13.  Device Setup Window – Command Options 

 

 
 

[Blank check before Erase check box] 

If this check box is checked, a blank check is performed before execution of the [Erase] and 

[Autoprocedure (EPV)] commands.  If the result of the blank check is OK, erase processing is not 

executed. 

 

[Read verify after Program check box] 

If this check box is checked, the written data is transmitted from the programmer, and verification is 

executed with the data written to the flash memory after execution of the [Program] and 

[Autoprocedure (EPV)] commands. 
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[Security flag after Program check box] 

Not usable  

 

[Checksum after Program check box] 

If this check box is checked, the flash memory checksum values of the target device are read from 

the target device after execution of the [Program] and [Autoprocedure (EPV)] commands.  

This value differs from the value displayed in the parameter window in the main window. 

 

<2> Security flag settings 

Not usable 

 

4.4.3 [View] menu 

Clicking the [View] menu displays the following pull-down menu. 

This menu consists of commands for setting whether to display the toolbar and status bar. 

 

Figure 4-14.  [View] Menu  

 

 
 

(1) [Toolbar] command 

Checking the [Toolbar] command displays the toolbar.  Unchecking the command hides the toolbar.  

 

(2) [Status Bar] command 

Checking the [Status Bar] command displays the status bar.  Unchecking the command hides the status bar.  
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4.4.4 [Help] menu 

Clicking the [Help] menu displays the following pull-down menu. 

 

Figure 4-15.  [Help] Menu  

 

 
 

(1) [About FPL] command 

The [About FPL] command opens the following program entry window and indicates the version.  

Clicking  OK  terminates the display. 

 

Figure 4-16.  About FPL Window 
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4.5 Programmer Parameter Window 
 

This window displays the settings of the programming parameters. 

 

Figure 4-17.  Programmer Parameter Window 

 

 
 

[Device] 

Updated after communication with the target device to display information about the target device. 

 

[Parameter file] 

Updated after [Setup] command execution to display information about a read parameter file. 

 

[Load file] 

Updated after [Load] command execution to select information about a selected program file. 

 

[Connection to device] 

Updated after [Setup] command execution to display information about the connection with the target device. 
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CHAPTER  5   USAGE  EXAMPLE 
 

 

This chapter explains a series of basic operations of the FPL with the GUI software, taking a case where the 

µPD70F3266 is used as the target device as an example.  This chapter covers how to start the system, execute the 

[Autoprocedure (EPV)] command, and program the target device. 

Refer to CHAPTER 4 OPERATION USING GUI SOFTWARE for the other commands and applications. 

 

The conditions of the series of operations described in this chapter are as follows. 

 

• Target system 

Target device: µPD70F3266 

Clock: 5 MHz 

Voltage level: 3.3 V 

Communication: UART  CH0 

 

• FPL 

Parameter file: 70F3266_CSI0.PRM 

Clock setting: 5 MHz  Multiplied by 4 

Port: COM2 (38,400 bps) 

MODE switch: 2 (VDD: 3.3, VDD2: N.C) 

Operation mode: Chip 

Write HEX: FPL_TEST.HEX 

Option setting: Read verify after Program 

 Blank check before Erase 

 

(1) Installing the GUI software 

Install the FPL GUI software in the host machine you are using, by referring to CHAPTER 3 SOFTWARE 

INSTALLATION (if the software has not been installed yet). 

 

(2) Installing the driver 

Install the USB driver in the host machine you are using, by referring to CHAPTER 3 SOFTWARE 

INSTALLATION (if the driver has not been installed yet). 

 

(3) Installing the parameter file 

Copy the parameter file for the µPD70F3266 to the hard disk and install it in <FPL-installation-path>\PRM. 

Download the parameter file from the following: 

 

 http://www.necel.com/micro/ods/eng/index.html (website in English) 

 http://www.necel.com/micro/ods/jpn/index.html (website in Japanese) 
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(4) Connecting and starting the system 

<1> Set the MODE switch to “MODE2”. 

<2> Connect the FPL with the host machine via the USB cable. 

<3> Check that the Power LED is turned on. 

<4> Check that the power to the target system is not turned on, then connect the FPL with the target system 

via the target cable. 

<5> Start the GUI software. 
 

Figure 5-1.  GUI Software Main Window 
 

 
 

(5) Setting the programming environment 

<1> Select [Device] → [Setup] from the menu bar. 

<2> The Standard tab of the Device Setup window for device setup is activated. 
 

Figure 5-2.  Device Setup Window – Standard Tab 
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<3> Click  PRM File Read  to open the parameter file selection window. 

 In this case, select the parameter file for the µPD70F3266, then click  Open . 

 

Figure 5-3.  Parameter File Selection 

 

 
 

<4> From the Port list box, select the communication port that matches the host machine being used. 

 

Figure 5-4.  Device Setup Window – Standard Tab <After Setting> 

 

 
 

Remark The selectable port can be checked with the Device Manager.  For details, refer to 3.3  

Confirmation of USB Driver Installation. 
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<5> Set the other displayed setting items to match the programming environment being used. 

 In particular, set "Supply oscillator" according to the specifications of the selected device. 

 In "Operation Mode", specify a flash memory range subject to operation.  Here, the following settings are 

assumed: 

 

Figure 5-5.  Device Setup Window – Advance Tab 
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<6> Switch to the Advance tab. 

 

Figure 5-6.  Device Setup Window – Advance Tab 

 

 
 

<Command options>  

Blank check before Erase: Checked  

Read verify after Program: Checked 

Security flag after Program: Not checked 

Checksum after Program: Not checked 
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<7> Click  OK .  The GUI software sets the parameters. 

 When the settings are completed, the following screen is displayed. 

 

Figure 5-7.  Completion of Parameter Setting 

 

 
 

“PRM File Read OK.” is displayed

Parameters are updated.
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(6) Selecting a user program 

 

<1> Select [File] → [Load]. 

<2> Select a program file to be written to the target device, then click  Open . 

 

Figure 5-8.  After Loading File 

 

 
 

(7) [Autoprocedure (EPV)] command execution 

Select [Device] → [Autoprocedure (EPV)] from the menu bar. 

When the [Autoprocedure (EPV)] command is executed, Blank Check → Erase → Program → Verify Note are 

executed sequentially for the µPD70F3266.  In this example, Read verify after Program is checked.  So, after 

the execution of the [Autoprocedure (EPV)] command, verification is performed to check if communication 

between the FPL and the target device has been performed normally. 

 

Parameters are updated.

“Success read HEX file.” is displayed. 
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Figure 5-9.  After EPV Execution 

 

 
 

(8) Terminating the system 

<1> If other devices need not be programmed, select [File] → [Quit] to terminate the GUI software.   

 All settings executed so far are saved in the FPL.INI file, so that those settings can be reused when the 

GUI software is restarted. 

<2> Disconnect the target cable from the target system. 

<3> Disconnect the USB cable from the FPL. 

 

(9) Restart 

When the system is restarted, the same screen as shown in Figure 5-6 appears. 

 

 

“...finish” is displayed.
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CHAPTER  6   CONNECTORS  AND  CABLES 
 

 

6.1 USB Connector (FPL) 
 

Figure 6-1.  Pin Layout of Power Supply Connector 

 

1 5

 
 

Table 6-1.  Pin Assignment of USB Connector 

USB Connector FPL Signal Name 

1 VCC_USB 

2 USBDM 

3 USBDP 

4 N.C. 

5 GND 

 
Connector part number:  UX60A-MB-5ST (made by Hirose Electric) 

 

Remark The recommended USB cable (Mini-B type) for connection with the host machine is the USB cable 

included with the IECUBE. 
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6.2 Target Cable Connector (FPL) 
 

Figure 6-2.  Pin Layout of Target Connector 
 

 
 

Table 6-2.  Pin Assignment of Target Cable Connector 

Target Connector FPL Signal Name 

1 GND 

2 VDD 

3 VDD2 

4 /RESET 

5 TXD 

6 RXD 

7 FLMD0 

8 FLMD1 

Connector part number:  DF3A-8P-2DSA (made by Hirose Electric) 

 

6.3 Target Cable Specifications 
 

Figure 6-3.  External View of Target Cable 
 

 
 

Table 6-3.  Pin Assignment of Target Cable  

Cable Specification Display Specification 

No. 1 Black GND 0. GND 

No. 2 Brown VDD 1. VDD 

No. 3 Red VDD2 2. VDD2 

No. 4 Orange /RESET 3. /RESET 

No. 5 Yellow TXD 4. TXD 

No. 6 Green RXD 5. RXD 

No. 7 Blue FLMD0 6. FLMD0 

No. 8 Purple FLMD1 7. FLMD1 

Supported header pin specification:  0.635 × 0.635 mm (length:  6 mm) 
 

Remark The recommended header pin that can be used with the target cable is FFC-7AMEP1 

(made by Honda Tsushin Kogyo). 

1 8 
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6.4 Target Connector (FPL-FA) 
 

Figure 6-4.  External View of Target Connector 

 

0 7

 
 

Table 6-4.  Pin Assignment of Target Connector 

Target Connector FPL-FA Signal Name 

0 GND 

1 VDD 

2 VDD2 

3 /RESET 

4 TXD 

5 RXD 

6 FLMD0 

7 FLMD1 

Connector part number:  FFC-7AMEP1 (made by Honda Tsushin Kogyo) 

 

6.5 FP4 Connector (FPL-FA) 
 

Figure 6-5.  External View of FP4 Connector  

 

 
 

Table 6-5.  Pin Assignment of FP4 Connector 

FP4 Connector FPL-FA Signal Name 

1 GND 

2 /RESET 

3 RXD 

4 VDD 

5 TXD 

11 VDD2 

12 FLMD1 

14 FLMD0 

6, 7, 8, 9, 10, 13, 15, 16 N.C. 

Connector part number:  8516-4500PL (made by Sumitomo 3M) 

 

Remark The recommended receptacle connector that can be used with the FP4 connector is 

7616-5002PL (made by Sumitomo 3M). 

1 

2 

15 

16 
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6.6 List of Interface Connections 
 

Table 6-6.  List of Interface Connections 

Signal Name <1> Target Cable Connector <2> Tip of Target Cable <3> Target Connector <4> FP4 Connector 

GND 1 0. GND 0 1 

VDD 2 1. VDD 1 4 

VDD2 3 2. VDD2 2 11 

/RESET 4 3. /RESET 3 2 

TXD 5 4. TXD 4 5 

RXD 6 5. RXD 5 3 

FLMD0 7 6. FLMD0 6 14 

FLMD1 8 7. FLMD1 7 12 

 

Figure 6-6.  Target Interface 

 

                                        

 
Target cable   FPL-FA   PG-FPL 

<1> 
<2> <3> <4> 
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CHAPTER  7   NOTES  ON  TARGET  SYSTEMS 
 

 

This chapter explains the basic notes on the target system for rewriting the flash memory in the microcontroller 

using the FPL. 

 

CPU Pin Design Proposal 

Do not connect the RESET signal generator on the target system to the RESET signal of the FPL.  Otherwise, a 

signal conflict will occur.  To avoid the conflict, isolate the RESET signal generator from the RESET signal of the 

FPL.  

Do not generate RESET while the FPL is connected.  This must be especially noted in a system that uses an 

external watchdog timer. 

RESET 

Connect the RESET signal of the FPL at a point where the status of the programmer RESET signal and that of 

the CPU RESET pin are the same. 

 

Correct connection: 

CPU 

FPL  RESET 

RESET 

 
 

Avoid the following RESET signal connection. 

• Connection to a point where the target CPU RESET rise time is slower than the FPL RESET rise time. 

 

Incorrect connection: 

CPU

OCFPL  RESET 

RESET 

 

It takes time for the CPU RESET pin to go high after the FPL RESET level goes from low to high. 
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CPU Pin Design Proposal 

RESET • Connection to a point where the target CPU RESET pin cannot be driven to low level by the FPL RESET 

signal. 

 

Incorrect connection: 

A 

CPU

FPL  RESET 

RESET 

 

When the FPL RESET is driven low, the level of the voltage at point A does not fall. 

Serial 

interface pin 

When the CPU port used by the FPL is also connected to the input of an external device, and if that device 

malfunctions, disconnect the external device or make it output high impedance. 

 

Example: 

Adverse effect 

FP4
connector 

Input 

External device 

CPU

S0/TxD 

 

While the CPU port used by the FPL is also connected to the output of an external device, and if a signal 

collision occurs, disconnect the external device. 

 

Example: 

 FP4
connector 

Collision 

Output

External device

CPU

S1/RxD

 

 

Other For the unused pins, refer to the user's manual of the device. 

Some devices have pins that must be processed differently.  For these pins as well, refer to the user's manual of 

the device. 

Example of pins processed differently: 

MODE 

CKSEL 

REGOUT 

REGIN, etc. 
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The following show examples of the interface circuits of UART (asynchronous communication port). 

Refer to the above design proposal for the pin processing of the device to be used. 

Figure 7-1.  UART Interface Circuit Example 
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Remarks 1. The FPL generally performs normally without pin connection. 

 2. For pin processing of the signals used with the FPL (TxD, RESET, RxD, FLMD0, FLMD1), pull up 

(pull down) according to CHAPTER 8 CIRCUIT DIAGRAMS. 
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CHAPTER  8   CIRCUIT  DIAGRAMS 
 

 

Figure 8-1.  Circuit Diagram of FPL Main Unit 
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Figure 8-2.  Circuit Diagrams of Main FPL Unit (1/3) 

(a) USB Power Generator 
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Figure 8-2.  Circuit Diagrams of Main FPL Unit (2/3) 

(b) Main Unit 
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Figure 8-2.  Circuit Diagrams of Main FPL Unit (3/3) 

(c) Target Interface Section 
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CHAPTER  9   TROUBLESHOOTING 
 
 

9.1 Trouble During Setup 
 

(1)  When installing the driver, the driver is not recognized by Plug and Play. 

Cause: 

The USB connector may not be inserted normally into the USB port of the personal computer. 

Action: 

Check that the USB connector is inserted fully into the USB port of the personal computer. 

Alternatively, disconnect the USB connector, then insert the USB connector again after a while. 

 

(2)  The driver file cannot be found at a specified location. 

Cause: 

The GUI software of the FPL may not be installed correctly. 

Action: 

Install the GUI software again by referring to 3.1 GUI Software Installation. 

 

(3)  “USB Serial Port” or “USB Serial Converter” is not displayed in the Device Manager.  Alternatively, the “!” or “×” 

is prefixed. 

Cause: 

The USB connector may not be inserted normally into the USB port of the personal computer. 

Action: 

Check that the USB connector is inserted fully into the USB port of the personal computer. 

Alternatively, disconnect the USB connector, then insert the USB connector again after a while. 

 

Cause: 

The driver may not be installed correctly. 

Action: 

<1> Right-click the driver marked with “!” or “×” when the FPL is connected to the personal computer and 

select  Remove  in the right-click menu. 

<2> Execute [Hardware Modification Scan] in the Device Manager. 

<3> Install the driver again with Plug and Play. 

 

Cause: 

The device may not be recognized (in the case of connection with the USB hub). 

Action: 

Try the following: 

• Disconnect the USB connector, then insert the USB connector again. 

• Connect the USB connector to another port of the USB hub. 

 If the same symptom occurs, do not use the USB hub, but directly connect the connector to the USB 

port of the personal computer. 
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9.2 Trouble During Operation (Main Unit) 
 

(1) When the FPL is connected to the personal computer but the Power LED is not turned on. 

Cause: 

The FPL or the USB port of the personal computer may be damaged. 

Action: 

Try a connection to another personal computer. 

 

(2) The Status LED is turned on when the FPL is not communicating with the target device. 

In accordance with the specifications of the FPL, the Status LED may turn on even if the FPL is not 

communicating with the target device. 

The Status LED is designated to blink during communication with the target device. 

 

(3) The “Add New Hardware Wizard” screen is displayed when the FPL is connected with a personal computer. 

Cause: 

If the USB connector of the FPL is not inserted into the USB port during installation but into another USB 

port, the FPL may be recognized as a new hardware item. 

Action: 

Install the driver by referring to 3.2 Driver Installation. 
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9.3 Trouble During Operation (Communication) 
 

(1)  Communication with the target device is not possible. 

Cause: 

The driver may not be installed correctly. 

Action: 

Check if “USB Serial Port” and “USB Serial Converter” are installed correctly by referring to 3.3 

Confirmation of USB Driver Installation. 

 

Cause: 

The port list box may not be set correctly. 

Action: 

Set the port confirmed with the Device Manager. 

 

Cause: 

There may be an incorrect connection between the target cable and target system. 

Action: 

Check if the connection is correct. 

Pay special attention to the following connections because the connections are confusing: 

 Connect TXD of the target cable to RXD of target device 

 Connect RXD of the target cable to TXD of target device 

 

Cause: 

The power may not be supplied to the target device correctly. 

Action: 

<1> Check that the clock is supplied in the target system. 

<2> Check that the power is supplied in the target system. 

 If the power or clock is supplied from the FPL, check if the setting of the MODE switch is correct. 

 

Cause: 

The PRM file selected in the Device Setup window may be incorrect. 

Action: 

Use a PRM file that matches the target device. 

Refer to CHAPTER 4 OPERATION USING GUI SOFTWARE for information about PRM files. 

 

Remark  A parameter file (.prc) for FlashPro3 is unusable. 

 

Cause: 

The supply oscillator setting selected in the Device Setup window may be incorrect. 

Action: 

Set the supply oscillator that matches the target device specifications and environment used. 

 

Cause: 

The speed list box setting selected in the Device Setup window may be incorrect. 

Action: 

Set the speed list box correctly by checking the user’s manual for the target device. 
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Cause: 

The power supply capacity of the USB port of the personal computer may be low (when the MODE switch 

is set to MODE2, MODE3, or MODE4). 

Action: 

Try using another personal computer or supply power from the target system by setting the MODE switch 

to MODE1. 

 

Cause: 

Security may be set. 

Action: 

Check that security is not set. 

 

(2) The Status LED does not blink during erase operation. 

 

In accordance with the specifications of the FPL, the Status LED may not blink during erase operation. 

To confirm the erasure status, check the following message in the action log window of the GUI software. 

 

 Message during erase operation: “Flash Erasing...” 

 Message for completion of erasure: “chip erase finish.” or “all block erase finish.” 

 

Cause: 

The power supply capacity of the USB port of the personal computer may be low (when the MODE switch 

is set to MODE2, MODE3, or MODE4). 

Action: 

Try using another personal computer or supply power from the target system by setting the MODE switch 

to MODE1. 
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APPENDIX  A   PRODUCT  SPECIFICATIONS 
 

 

A.1 Hardware Specifications 
 

Table A-1.  Specifications of Main Unit  

 MIN. TYP. MAX. 

Operating supply voltage (VDD_USB) 4.4 V 5.0 V 5.25 V 

Supply current (VDD_USB)   500 mA 

Current consumption of the main unit  35 mA  

5.0-V outputNote 4.2 V 4.8 V 5.05 V 

3.3-V output 3.0 V 3.3 V 3.6 V 

Target VDD voltage 2.7 V  5.5 V 

VDD output current   200 mA 

VDD2 output current   200 mA 

 

Note The 5 V output of the FPL depends on the USB port of the host machine.  If the supply power of the USB 

port is unstable or does not satisfy the specifications of the target device, set the MODE switch to MODE1 

to use the power supplied from the target system. 

 

Table A-2.  Temperature Range 

Operating temperature range 0 to 40°C (no condensation) 

Storage temperature range −15 to 60°C (no condensation) 
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A.2 Dimensions 
 

(1)  PG-FPL 

Figure A-1.  Dimensions of FPL Main Unit 

 

 
 

 Unit: mm 
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(2)  FPL-FA 

Figure A-2.  Dimensions of FPL-FA Main Unit 
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(3)  Target cable 

Figure A-3.  Dimensions of Target Cable 

 

 
 

 

Figure A-4.  Dimensions of Tip of Target Cable 
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Connector part number:  PS-SF-C2-1 (manufactured by JAE) 
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APPENDIX  B   WARRANTY AND SUPPORT 
 
 

B.1 Warranty 
 

The PG-FPL (including hardware and software) can be exchanged with a new product for free only when it has an 

initial failure.  

NEC Electronics' warranty does not cover any other failure. 

 

B.2 Support 
 

NEC Electronics will not provide any support for the PG-FPL. 

For initial failures, consult a distributor or dealer. 

The latest information concerning the PG-FPL and the supported parameter file are available on the following 

webpages. 

 

Site:  http://www.necel.com/micro/ods/jpn/index.html (Japanese) 

http://www.necel.com/micro/ods/eng/index.html (English) 
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